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General Navigation Tips

The screen is split into four frames: The Menu to
the left [1] with the navigation arrows for navigating
the whole help document, and a box for entering a
page number.

The top shows the Contents List [2] divided into
chapters. The Glossary [4] of the most important
technical terms is shown at the bottom. You can
switch between the Glossary and an Index in this
frame. Whichever you choose, clicking the
underlined words will link you directly to the most
relevant part of the corresponding help page.

The middle frame shows you the current help page
[3].

Choosing the Control Method:

There are two ways to navigate the help pages for
IBECad .

1. Interactive Navigation
This allows you to decide for yourself which texts
you need to read. Place the mouse cursor over the
rectangles drawn onto the screenshots to get a
more detailed description.

2. Continuous Navigation
This mode leads through the document
sequentially. All details will be shown one after the
other, simply press the 'Next' button (right arrow in
the Navigation Panel [1]) to move through the
document one step at a time.

Select either interactive or continuous navigation.

1 2

3

4
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Drawing Your Own Components.

IBECad represents a tailor-made tool for the
creation of cut parts. You can create geometric
figures and have all possible options for
constructing a drawing.

Note:

If in the next pages you see 'LC' this means Left
Click, unless specifically noted otherwise.

The cursor can be moved with the mouse, via the
command line or with the arrow keys.

Letters in angled brackets (<Esc> <CR> <A>)
describe buttons on your keyboard.

This is the interface of IBECad . The middle frame is a
drawing board, the header and footer areas are
menu, command and status bars.

1
2

3

4
5
6

1

The menu bar allows you to start new drawings or import existing ones, set
formats for colours, lines and pens, launch drawing commands, edit your
drawing and set general settings. The menu items are described in the 'The
program's most important menu items' chapter.

2

This symbol bar offers a selection of most commonly used drawing
commands available at the click of an icon. You can configure this
panel; there is a description of the basic settings in the 'Entering
commands via the symbol bar' chapter.
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3

This are is the 'Drawing Board' with a cursor in the middle, shown by a
hairline cross. Right-click in the drawing area to access a Pop-up menu , via
which you can give instructions to the program for searching elements or
displaying the drawing.

If you pressed the symbol for displaying 'information about geo-elements' in
the format bar [4], the information will be shown in the status bar when you
place the cursor over an element in your drawing.
A symbol corresponding to the geo point will be displayed at the cursor when
these are touched.

Use the mouse wheel to zoom in and out around the cursor position.

7
The top area gives instructions for Searching for elements around
the cursor. The menu items in the middle allow you to control the
display and the last menu item sets a new zero-point .

Alternatively, you can zoom in and out by using the left and right
mouse buttons while holding <Ctrl>, or also use the <+> and <->
buttons.

8
The search menu items in the Pop-up menu mean, from top to
bottom:

1. Find the nearest geo point to the cursor.
2. Find the nearest element that is touched by the cursor rectangle.
3. Find the nearest intersection inside the cursor rectangle.
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4. Find the mid-point of the element inside the cursor rectangle.

9
The menu items for display settings in the Pop-Up menu mean, from
top to bottom:

1. Go to the origin.
2. Zoom in.
3. Zoom out.
4. Move around the drawing board.
5. Re-draw the drawing (neuDraw); Fragmented parts will be swept

clear.
6. Fit the workpiece to the screen.

12
A drawing has a zero-point in the bottom left corner. This is
identified as 'zero-poiont 0'. You can move the zero-point at
any time, the new zero-point is then identified as 'zero-point 1'
(here to the left below the cursor). For a description of this
procedure, see the 'zero-point' chapter.

4

The 'Format line' shews the defined formats for line type and style, and offers options
for switching the display of elements on and off. The penultimate icon enables the
display of information about the drawing element the cursor is resting on.
Use the furthest icon right to show or hide the grid; important when starting a new
drawing. Tip: The grid can obstruct when trying to 'capture' geometry points. In this
case, simply hide it.

You can abort any command sequence by pressing <Esc> or right-clicking.

5
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This is the program's 'Command line'. This line allows you to enter commands and
their codes more accurately than with the mouse. The commands can be found in the
descriptions of the draw functions.
The next step in the editing sequence will be shown when using text mode. If you wish
to abort an editing sequence, press the <Esc> key.

The command line can also appear in an input format , whereby the content of the line
changes according to the instructions you gave the program.
The input format can be activated directly by pressing <F2>. You will find a
description of the content in the functions' corresponding pages.

10

You can enter the position of the cursor in input format, either as X/Y coordinates, or polar
coordinates (angle, offset). Press the corresponding button in the left panel and enter the
required position. Click the arrow button next to the position field to move a marker to the new
position. Click the 'Apply' button to move the cursor to the marked position.

The bottom buttons on the left panel allow you to move the cursor to a new position using a
triangular calculation .

To keep the input format active during further editing, mark the checkbox at the far top right.

11

To enter a new cursor position using a triangular calculation, choose first between the side
lengths and the angle of the side, and enter a value under X or Y. The cursor will jump directly
to the newly calculated position.

6

Status bar with information about the cursor position and the drawing. In the text fields
to the right are the current layer number, pen number, line type and zero-point. The
current zero-point is important for positioning a start-point when drawing new
elements.

The layer number in IBECad is always 1. You can place 80,000 elements in this layer.
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The Program's Most Important Menu Items.

The menu bar allows you to start new drawings or
import existing ones, set formats for colours, lines
and pens, launch drawing commands, edit your
drawing and set general settings. Some menu
items are available directly from the symbol bar.

Die menuleiste von IBECad .

1 2 3 4 5 6 7 8

1

'File' allows you to start new drawings or import existing ones, import
DXF files, and exit the CAD module.

When you start a new drawing, we recommend you click 'Show Grid'
in the 'Format line' or 'Re-draw' in the 'Symbol bar' .
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2
The 'Edit' menu gives options for identifying and modifying
elements in your drawing. You must identify individual
elements or groups of elements before clicking on the
relevant editing option. You will find descriptions of the edit
funtions in the chapter 'The Edit Functions' .

3
'Display' allows you to zoom, redraw and rescale to fit the whole
drawing on screen.

4

'Format' allows you to check and set rules for colours, lines and pens, and
zero-points. Input these settings via a dialog box .
By setting rules you have the option to group elements, for better control when
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editing.
'Units' allows you to set the units of measurements for the drawing on the screen. You
can only change this when you have an empty layer, or a new drawing on screen.
'Cursor step' sets how many mm the cursor should move at a time in the X and Y
axes.
'Format' allows you to set the paper size for your drawing: DIN A0 to A4.
The 'Settings' menu item allows you to set system settings, which will not be
described here.
The last menu item 'Search area' sets the size of the search area around the cursor.
The effects of this can be seen by the resized box around the cursor.

9
Set the pen types, and allocate the line
types, thicknesses and colours. Note: The
pen thickness field is only shown if the
selection box 'Show pen thickness' is
marked.

5
Launch the commands for constructing your drawing's
elements from the 'Draw' menu:

Lines
Circles
Arcs
Ellipses
Tangents

These menus have further options in their submenus, as
described on their own pages.

These options are launched directly:

Rectangle and
Fillet
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10
Draw circles with different start-points.

11
Draw arcs with different start-points.

12
Draw ellipses from various base elements.
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13
Lay a tangent on one or two circles.

6
The widest variety of methods to modify your drawing
elements. Select the corresponding menu item and identify
the relevant elements in the command line as instructed in
the command line.

Trim - allows one element to be pulled toward another.
Fit - shortens one element onto the nearest geometry point.
Separate - removes a section of an element between two
other elements.
Split - splits an element into equal parts. Launch the
command in the command line (option 3) and give the
number of parts to split into.
Create corner - joins two elements at a closed corner.
Regional scale - sets a scale on the drawing. Undo by
're-drawing' .
Undo Fillet - Removes a fillet arc from a corner.

7
Find and edit simple texts in IBECad . ' True Type Texte '
have their own sub-menu.
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14
Find and edit 'True Type Texts'.

8
'General' settings and settings about the mode of
measurement.
There is a separate Dialog for setting grid
parameters.

The options for dimansioning are given in a
separate sub-menu .

15
Dialog for setting up grid parameters. The grid can
be shown or hidden by clicking a button in the
Format line .
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16
You can set measurements in your drawing under
XY dimensioning for Lines and construction lines .

You can add dimensions between two points using
the 'Point Dim.' option.

There are separate menu options for dimensioning
angles, arcs and circles.

17
You can use the 'XY Dimensioning'
option to dimension lines and
construction lines directly or
cascading, with or without
measurements.

18
The 'Point dim.' option gives you the
ability to mark a dimension between
two points.
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Entering Commands Using the Symbol Panel.

The Symbol Panel's functions from left to right:

Identify drawing elements.
Draw elements.
Modify elements.
View options.

The meaning of each symbol is given as a 'tooltip'
to aid use.

The symbol panel allows ou to access
commands directly with just one click of the
corresponding icon.

1 2 3 4 5

1
This button activates the 'Identify' an element function.

If you wish to identify an area, stretch a selection box over that area by holding the left
mouse button. All elements enclosed by that box will be marked.
If you LC an element, the geometry points will be marked. You can then click the
points individually to edit them.
Right-click a geometry point for a Dialog window with all information about that point.

If you right-click in the drawing area, a selection menu will be shown with which you
can identify groups of contours.

Press <Esc> to exit the function.

If the cursor is near a geometry point, you can press <Alt>LC to 'capture' it.

6
This menu point allows you to identify whole groups of
contours.
First identify an element. Then right-click the element an
select the menu-point.

You can identify a whole contour with the same colour by
calling the function, then placing the cursor over the contour
and pressing <b>.
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7
Dependant on the geometry point you will get a
dialog window here with all the individual data
about the point. You can change values from this
window and modify the drawing by clicking 'apply'.

2
These icons launch draw commands. Take note of the tips
given in the Command Line ; they will guide you through
each command.

Draw rectangle.
Draw a circle from its diameter.
Draw a circle from its start and end points.
Draw a line from its start and end points.
Fillet a corner.
Create a corner.

3
These buttons allow you to draw construction lines.

Draw tangential construction line.
Draw horizontal construction line.
Draw vertical construction line.
Draw a construction circle on two elements.
Draw a construction line at an angle.

Tip: Select a different Line type for construction lines so that it is
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easier to manage them separately.

4
These buttons allow you to adapt elements. The commands are
identical to those available under the 'Modify' menu.

Delete element between two elements.
Fit element between two elements.
Direct trimming of two elements.

5
These buttons signify:

Undo.
Show zoom window.
Re-Draw. Alternatively select 'Re-Build' from the Pop-up menu .
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Different Ways of Drawing Elements

Elements can be edited in different ways. Access
the functions via the menu. Before you attempt to
edit an elements, you must mark, or identify , one
or more elements.

The edit functions are accessible through the menu
bar [1].

1

2

1
Use the menu to access an edit function. The
relevant elements must be identified first.
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2
These elements represent the foundation for describing the edit
functions. The mode of operation shall be explained through them.
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Copy / Turn Elements.

Copy in a row/column:

Select menu pooint [1] 'Copy/Turn'
LC in the drawing window; selecet 'Row/Column' in
the selection dialog.
Select the 'Row' or 'Column' tab.
Enter the number of rows or columns and the
offsets between the parts.
Click 'Apply'.

Copy around a center:

Select menu item [1] 'Copy/ Turn'.
LC on the center; select the 'Turn' tab in the
selection dialog.
Select the 'Quantity/Diff' or 'Quantity/Angle' tab.
Enter the quantity of parts and either the difference
angle or the total angle.
Click Apply.

The program also allows for freehand copying. This
function is described in the 'Freehand copying'
chapter.

This function allows elements to be copied in rows,
columns or a grid, or around a reference (center)
point.
The element(s) to be copied must be identified
before copying.

1

2

1
Select the menu item 'Copy/Turn'. The relevant
elements must be identified first.
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2
In this picture the small circle to the right has been identified, and is
to be copied in multiple rows. To do this, select 'Copy/Turn' and LC
the reference point.
Select the copying method by choosing the tab 'Row/Column' or
'Turn' .

3

Select the 'Rows' tab and enter the number of rows,
and the offset between parts. Click 'Apply' to copy
the circle the given number of times into rows.
There are separate options for 'Columns' and 'Grid'
.
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5

This is the selection dialog for columns. There are
separate options for 'Rows' and 'Grid' .

6

This is the selection dialog for a grid. There are
separate options for 'Rows' and 'Columns' .
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4
The result of copying in multiple rows. To copy into columns, work in
the same manner, but use the 'Columns' option.

7

This is the selection dialog for copying around a
center with an offset angle. Enter the number of
elements and the difference angle between each
copy. There is a separate option for 'Total angle' .
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8

This is the selection dialog for copying around a
center with a total angle. Enter the number of
elements and the total angle. There is a separate
option for 'Difference angle' .
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Free Copy.

Free-copying drawing elements:

Select menu item [1] 'Free copy
LC in the drawing window; the element will be 'tied'
to the cursor.
Move the element to the required new position.
LC to 'release' the element, copying it to its new
location.

Free copy via Dialog :

Select menu item [1] 'Copy/Turn'
LC in the drawing window; select 'Move/Copy' from
the selection dialog.
Select the 'Copy' button.
enter X/Y values.
Click apply.

This function allows you to copy geometric
elements in the drawing. You must first mark the
element; it must be identified .

1

2

1
Select the 'Free Copy' menu item to move with the
mouse, or 'Copy/Turn' to move using a dialog.
The relevant elements must be identified first.
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2
The small circle to the right has been identified and is to be copied.
Select the 'Free Copy' option and LC the reference point.

Move the
circle to the required position and LC to copy it.

3
When copying, an offset line between the
reference point and the new position will be shown
as a check. LC to place the element.

4
The result of copying.
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5

Select the 'Move/Copy' tab, mark the 'Copy' button
and enter the X/Y position. Click 'Apply' to copy the
circle to the given coordinates.
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Free Move.

Free-moving drawing elements:

Select menu item [1] 'free move'
LC in the drawing window; the element will be 'tied'
to the cursor.
Move the element to the required new position.
LC to 'release' the element, placing it in its new
location.

Move via Dialog :

Select menu item [1] 'Copy/Turn'
LC in the drawing window; select 'Move/Copy' from
the selection dialog.
Select the 'Move' button.
enter X/Y values.
Click apply.

This function allows you to move elements around
the drawing. You must first mark the element; it
must be identified .

1

2

1
Select the 'Free Move' menu item to move with the
mouse, or 'Copy/Turn' to move using a dialog.
The relevant elements must be identified first.
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2
The small circle to the right has been identified and is to be moved.
Select the 'Free Move' option and LC the reference point.

Move the
circle to the required position and LC to place it.

3
When moving, an offset line between the reference
point and the new position will be shown as a
check. LC to position the element.

4
The result of moving.
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5

Select the 'Move/Copy' tab, mark the 'Move' button
and enter the X/Y position. Click 'Apply' to move the
circle to the given coordinates.
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Scaling.

Scaling geometric elements:

Select menu item [1] 'Scaling'.
LC on the drawing window to call a dialog box .
Enter the scaling factor.
Click 'Apply'; the elements is rescaled.

The function allows an element's size to be
increased or reduced. The relevant element must
be identified first.

1

2

1
Select the 'Scaling' menu item.
The relevant elements must be identified first.
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2
The small circle to the right has been identified and is to be rescaled.
Select the 'Scaling' option and LC the element.
a dialog box appears for you to enter the scaling factor.
Enter the value and click 'Apply'.

3
Enter the scaling factor for the increase or
reduction in size; the element will be re-drawn .

4
The result of scaling.
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Mirror.

Mirroring geometric elements:

Select the menu item [1] 'Mirror'
LC the reference point.
LC the start point
LC the end point

This function allows you to copy geometric
elements in the drawing. You must first mark the
element; it must be identified .

1

2

1
Select the 'Mirror' menu item.
The relevant elements must be identified first.
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2
Both circles have now been identified and are to be mirrored. To do
this, select the 'Mirror' menu item and LC the reference point. The
cursor 'runs' along the horizontal or vertical axis.
Then click the start and end point. The elements are shown mirrored
along the mirroring axis. The start and end points are freely
selectable and are not bound to the reference point!

3
The mirrored element.
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Clipboard.

Copying to the clipboard:

Select menu item [1] 'Copy to Clipboard'.
LC at reference point.

Pasting from the clipboard:

Select menu item [1] 'Paste from Clipboard'.
LC at reference point.

An element can be copied to the clipboard for use
any number of times in the drawing. The copy is
related to a reference point you set when you save
to the clipboard.
You must first mark the element; it must be
identified .

1

2

1
Select the menu item 'Copy to the Clipboard', or
'Paste from the Clipboard' respectively.
The relevant elements must be identified first.
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2
Both circles have been identified for copying to the clipboard here.
Select the menu item 'Copy to clipboard' [1] and LC the reference
point.

To paste, select the 'Paste from clipboard' menu item [1] and LC to
copy the element, from its reference point, at the cursor position.
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Various Ways to Draw Elements.

Elements can be drawn in different ways. You can
select the function via the menu, symbol bar, or
command line.

The descriptions in the following pages will follow a
tabular format.
Input via the command lin is always shown as such,
with the given example dimensions as an example.
The code always stands for the corresponding
function and is listed as command code or
numerical code.

Note: If you read 'LC' in the following descrptions
then, unless specifically stated otherwise, this
means 'Left Click'.
The cursor can be moved with the mouse, via the
command line, or with the arrow keys.

A drawing consists of various elements which,
when combined, give a workpiece. When drawing,
all elements are related to the origin (o or 1).

1
2 3

4

1

The options for entry via the menu panel are given in the 'menu
panel' chapter.

2
The most regularly used commands are easily accessible
via the corresponding icon in the Symbol bar .

3
There is also a quick access route for drawing construction lines;
click the corresponding icon in the Symbol panel .
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4

You can make direct, exact inputs about an element's dimensions in the Command
Line . There are examples listed with the required codes in the individual descriptions
of each drawing command.
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Set the Zero-point as Reference Point.

Define the Zero-point.
Command: NULLPD
Code: 00
Parameter: Zero-point number
Example: 00 1

Menu: yes
Symbol: no
-
Select Zero-point.
Command: NULLPW
Code: 01
Parameter: Zero-point number
Example: 01 1

Menu: yes
Symbol: no
-

Function:
Set a zero-point, or select a zero-point as a future
reference point.

1

1
Set or select a zero-point via:

1. Command Line

1. Enter the command or code and parameter into the
command line.

2. PopUp menu

1. Right-click in the drawing window.
2. Click the bottom menu point.

3. Function key <F5>
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Setting the Start-Point for a Draw Function.

Start-point relative to the cursor position.
Command: ST
Code: 1
Parameter: x, y
Example: 1 100 50
-
Start point relative to the current origin.
Command: STN
Code: 11
Parameter: x, y
Example: 11 100 50
-
Start point Radius, Angle
Command: STP
Code: 12
Parameter: Angle, Radius
Example: 12 30 100
-

Function:
Positions the cursor at a start-point for further
drawing commands

1

1
Set the start-point via:

1. Command Line

1. Enter the command or code and parameters in the
command line.



IBECad

Date: 1.10.2006Page: 39

Drawing a line.

Command: VEKTOR
Code: 150
Parameter: XS,YS; XE,YE- Input is made
sequentially.
Example: 150; Cursor to start point; <CR> Cursor
to end point; <CR>.
Menu: yes
Symbol: ja
-
Command: VE
Code: 2
Parameter: XE,YE
Example: 2 100 50
-
Abort the function with <Esc>!

Function: Draws a line from the given start point to
the given end point.

The VE command allows a line to be drawn from the
current cursor position to the coordinates entered as
parameters. By continually entering coordinates you
can create unbroken outlines.

1

1
Drawing a line via:

1. Menu

1. Select the function 'Draw > Line'.
2. Move the cursor to the start point, press LC.
3. Move the cursor to the end point, press LC.

2. Symbol

1. Click the 'Line' icon.
2. Move the cursor to the start point, press LC.
3. Move the cursor to the end point, press LC.

3. Command line

1. Enter the command or its code in the command line.
2. Move to the start point and press <CR> or LC.
3. Move to the end point and press <CR> or LC.
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You can create whole unbroken groups of lines by
continually adding lines from the last cursor position using
Code 2.
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Drawing a Rectangle.

Command: RECHT
Code: 39
Parameter: x, y, Angle
Example: 39 100 50 0

Menu: yes
Symbol: ja

Function: Draws a rectangle from the current cursor
position to the coordinates given as a parameter at
the given angle.

1

1
Draw a rectangle via:

1. Menu

1. Select the 'Draw > Rectangle' function.
2. Move the cursor to the start point, press LC.
3. Move the cursor to the end point, press LC.

2. Symbol

1. Click the 'Rectangle' symbol.
2. Move the cursor to the start point, press LC.
3. Move the cursor to the end point, press LC.

3. Command line

1. Place the cursor at the start point.
2. Enter the command or code in the command line.



IBECad

Page: 42Date: 1.10.2006

Drawing a Circle by its Radius.

Command: KR
Code: 3
Parameter: Radius
Example: 3 50

Menu: yes
Symbol: ja

-
Abort function with <Esc>!

Function: Draws a circle from the current cursor
position with the radius entered as a parameter.

1

1
Draw a circle by its radius via:

1. Menu

1. Select the function 'Draw > Circle > Center/Radius'.
2. Move the cursor to the start point, press LC.
3. Move the cursor to the end point, press LC.

2. Symbol

1. Click the 'Circle/Radius' symbol.
2. Move the cursor to the start point, press LC.
3. Move the cursor to the end point, press LC.

3. Command line

1. Place the cursor at the start point.
2. Enter the command or code and the radius in the command

line.
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Drawing a Circle Against Two Elements.

Command: HLKR
Code: 227
Parameter: GE1; GE2; Radius - Inputs are made
sequentiall
Beispiel: 227 - Enter parameters as prompted in
the command line

Menu: yes
Symbol: yes
-
Abort the function with <Esc>!

Function: Draws a circle with the given radius
tangentially touching two identified elements. (GE).

1

1
Draw a circle against 2 elements via:

1. Menü

1. Select the function 'Draw > Circle > Circle on 2
elements'.

2. Move the cursor to the first element and press LC.
3. Move the cursor to the second element and press LC.
4. Enter the radius in the command line.

2. Symbol

1. Click the symbol for 'Circle on 2 elements'.
2. Move the cursor to the first element and press LC.
3. Move the cursor to the second element and press LC.
4. Enter the radius in the command line.

3. Befehlszeile

1. Enter the command or code in the command line.
2. Move the cursor to the first element and press <CR>.
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3. Move the cursor to the second element and press <CR>.
4. Enter the radius in the command line.
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Drawing a Circle Against Three Elements.

Command: BO3GO
Code: 246
Parameter: GE1; GE2; GE3 - Inputs are made
sequentially
Example: 246 - Enter parameters as prompted in
the command line

Menu: yes
Symbol: no

Function: Draws a circle tangentially touching three
identified elements. (GE) (Inkreis).

1

1
Draw a circle against 3 elements via:

1. Menu

1. Select the function 'Draw > Circle > Circle on 3 elements'.
2. Move the cursor to the first element and press LC.
3. Move the cursor to the second element and press LC.
4. Move the cursor to the third element and press LC.

The circle will be calculated automatically and placed
against all three elements.

2. Command line

1. Enter the command or code in the command line.
2. Move the cursor to the first element and press <CR>.
3. Move the cursor to the second element and press <CR>.
4. Move the cursor to the third element and press <CR>.
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Draw a Circle Through Three Points.

Command: no
Code: 375
Parameters: SP; BP; EP - Inputs are made
sequentially
Example: 246 - Enter parameters as prompted in
the command line

menu: yes
Symbol: no

Function: Draws a circle through 3 points, perimeter
to lie on the the start point (SP), second point (Arc
point BP), end point (EP).

1

1
Draw a circle through three points via:

1. Menu

1. Select the function 'Draw > Circle > Circle through 3
points'.

2. Move the cursor to the start point and press LC.
3. Move the cursor to the second point and press LC.
4. Move the cursor to the end point and press LC.

The Circle will be calculated automatically and located on
the three points.

2. Command Line

1. Enter the command or code in the command line.
2. Move the cursor to the start point and press <CR>.
3. Move the cursor to the second point and press <CR>.
4. Move the cursor to the end point and press <CR>.

The Circle will be calculated automatically and located on
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the three points.

2
A typical circle with the perimeter through three
points.



IBECad

Page: 48Date: 1.10.2006

Draw An Arc Using Arc-Points and Mid-Point.

Command: BOGEN1
Code: 152
Parameter: XS,YS; XE,YE; XM,YM - Inputs are
made sequentially.
Example: 152 - Enter parameters as prompted in
the command line.

Menu: yes
Symbol: no
-
Abort function with <Esc>!

Function: Draws an arc with (S)tart-, (E)nd- and
(M)id-points.

1

1
Draw an arc from its start-, end- and mid-points via:

1. Menu

1. Select the function 'Draw > Arc > Startpoint, Endpoint,
Midpoint'

2. Move the cursor to the start point and press LC.
3. Move the cursor to the end point and press LC.
4. Move the cursor to the mid point and press LC.

2. Command Line

1. Enter the command or code in the command line.
2. Move the cursor to the start point and press <CR>.
3. Move the cursor to the end point and press <CR>.
4. Move the cursor to the mid point and press <CR>.
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Draw an Arc Using Three Arc-Points.

Command: BOGEN2
Code: 153
Parameter: XS,YS; XB,YB; XE,YE - Inputs are
made sequentially.
Example: 153 - Enter parameters as prompted in
the command line.

menu: yes
Symbol: no

-
Abort the function with <Esc>!

Function: Draws an arc from its (S)tart-, (B)Arc and
(E)ndpoint.

1

1
Draw an arc from three points via:

1. Menu

1. Select the function 'Draw > Bogen > Startpoint,Point on arc,
Endpoint'.

2. Move the cursor to the start point and press LC.
3. Move the cursor to the second point and press LC.
4. Move the cursor to the end point and press LC.

2. Command Line

1. Enter the command or code in the command line.
2. Move the cursor to the start point and press <CR>.
3. Move the cursor to the second point and press <CR>.
4. Move the cursor to the end point and press <CR>.

The Arc will be calculated automatically and laid across the
three points.
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2
The completed arc through three points. Use
<Esc> to abort the function.
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Draw an Arc on a Tangent from an Element.

Command: BOGEN3
Code: 154
Parameter: XE,YE - Inputs are made sequentially.
Example: 154 - Enter parameters as prompted in
the command line.

Menu: yes
Symbol: no

-
Abort the function with <Esc>!

Function: Draws an arc from the last element to the
given (E)ndpoint.

1

1
Draw an arc tangentially from an element via:

1. Menu

1. Select the function 'Draw > Arc > Tangential from an
existing element'.

2. Move the cursor to the end point and press LC.

2. Command Line

1. Enter the command or code in the command line.
2. Move the cursor to the end point and press LC <CR>.

The Arc will be calculated automatically and tacked onto
the existing element.
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2
The completed arc from an existing element to a
given (E)ndpoint. Use <Esc> to abort the function.
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Draw an Arc Tangential to Two Elements.

Command: BO2GO
Code: 66
Parameter: GE1; GE2; Radius; <CR>, <N>, <A> -
the inputs are made sequentially.
Example: 66 - Enter parameters as prompted in the
command line.

Menu: yes
Symbol: no

-
Abort the function with <Esc>!

Function: Draws an arc tangential to two drawing
elements (1, 2).

1

1
Draw an arc tangential to two elements via:

1. Menu

1. Select the function 'Draw > Arcs > Tangential to two
elements'.

2. Move the cursor to the first element and press LC.
3. Move the cursor to the second element and press LC. -

Cursor will go to the mid-point.
4. Enter the radius in the command line or confirm the

suggested mid-point.
5. Accept the arc with <CR> or reject the arc with <N> - the

opposite arc will be offered.
6. Accept the arc with <CR> or abort the funtion with <A>.

2. Command Line

1. Enter the command or code in the command line.
2. Move the cursor to the first element and press <CR>.
3. Move the cursor to the second element and press

<CR>.



IBECad

Page: 54Date: 1.10.2006

4. Enter the radius in the command line.
5. Relpy to the prompts with <CR>, <N> or <A> (as

above).
The opposite arc laid tangentially on the existing elements.

2
The opposite arc laid tangentially on two elements.
Use <Esc> to abort the function.
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Draw a Full Ellipse with all Inputs.

Command: ELLIPSV
Code: 165
Parameter: Large Radius; Small Radius; Angle of
Inclination for Large Axis; - Inputs are made
sequentially.
Example: 66 50,50 100 50 15.

Menu: no
Symbol: no

-
Once an ellipse has been defined, it can be copied
to multiple mid-points simply by clicking.
Abort the function with <Esc>!

Function: Draws a full ellipse.

Note: Dependant on your machine, ellipse may have
to be cut as Lines (Vectors) or Arcs . For this reason
IBECad offers both construction options.

1

1
Draw an ellipse from the command line:

1. Enter the command or code in the command line.
2. Move the cursor to the mid-point and press <CR>.
3. Enter the size of the large axis.
4. Enter the size of the small axis.
5. Enter the angle of inclination for the large axis.
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Drawing Full-Ellipses with Lines.

Command: VELLIP
Code: no
Parameter: Mid-point; Start-point; Dialog input ; -
Inputs are made sequentially.
Example: VELLIP; Start-point; Dialog.

Menu: yes
Symbol: no

-
Once an ellipse has been defined, it can be copied to
multiple mid-points simply by clicking.
Abort the function with <Esc>!Function: Draws a full ellipse with lines.

1

1
Draw an ellipse via:

1. Menu

1. Select the function 'Draw > Ellipse > Ellipse from
vectors'.

2. Move the cursor to the mid-point and press LC.
3. Enter the ellipse's values in the dialog .
4. Click 'Apply'.

2. Command Line

1. Enter the command or code in the command line.
2. Move the cursor to the mid-point and press <CR>.
3. Enter the ellipse's values in the dialog .
4. Click 'Apply'.
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2
This dialog is for defining the ellipse. Click the
'apply' button to draw the ellipse.
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Drawing a Full Ellipse from Arcs.

Command: BELLIP
Code: no
Parameter: Mid-point; Start-point; Dialog input ; -
Inputs are made sequentially.
Example: VELLIP; Start-point; Dialog.

Menu: yes
Symbol: no

-
Once an ellipse has been defined, it can be copied to
multiple mid-points simply by clicking.
Abort the function with <Esc>!Function: Draws a full ellipse with arcs.

1

1
Draw an ellipse via:

1. menu

1. Select the function 'Draw > Ellipse > Ellipse from
arcs.

2. Move the cursor to the mid-point and press LC.
3. Enter the ellipse's values in the dialog .
4. Click 'Apply'.

2. Command Line

1. Enter the command or code in the command line.
2. Move the cursor to the mid-point and press <CR>.
3. Enter the ellipse's values in the dialog .
4. Click 'Apply'.
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2

This dialog is for defining the ellipse. Click the
'apply' button to draw the ellipse.
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Draws Tangents to an Arc or Circle.

Command: TANPK
Code: 57 1
Parameter: XP,YP; Element - Inputs are made
sequentially.
Example: 57 1; Cursor to Startpoint; <CR> Cursor
tof Element; <CR>.

Menu: yes
Symbol: no

-
Abort the function with <Esc>!

Function: Draws a tangent from a (P)oint on a circle
or an arc.

1

1
Draw a tangent via:

1. Menu

1. Select the function 'Draw > Tangents > Point/Circle'.
2. Move the cursor to the start point and press LC.
3. Move the cursor to the circle/arc and press LC.

2. Command Line

1. Enter the command or code in the command line.
2. Move the cursor to the start point and press LC or <CR>.
3. Move the cursor to the circle/arc and press LC or <CR>.

The Tangent will be laid against the circle.
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2
The tangent will be laid from the start point to the
circle/arc.
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Draw Tangents Between Two Circles.

Command: TAN2K
Code: 46
Parameter: E1; E2 - Inputs are made sequentially.
Example: 46; Cursor to first circle; <CR> Cursor to
second circle; <CR>.

Menu: yes
Symbol: no

-
Abort the function with <Esc>!

Function: Draws a tangent from one circle (E1) to
another circle (E2). A selection allows you to choose
between four different tangents.

1

1
Draw a tangente via:

1. Menu

1. Select the function 'Draw > Tangents > 2 Circles'.
2. Move the cursor to the first circle and press LC.
3. Move the cursor to the second circle and press LC.
4. Select tangent with <A> (or spacebar) - press LC.

2. Command Line

1. Enter the command or code in the command line.
2. Move the cursor to the first circle and press <CR>.
3. Move the cursor to the second circle and press <CR>.
4. Select tangent with <A> - press <CR>.

Use <A> or the spacebar to toggle between the four
available options for setting the tangent on the circles.
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2
The tangent can be laid inside or outside . Press
<CR> or click the mouse and the Tangent will be
drawn.

3
The tangent can be laid indside or outside. This is
the outside variant. You can switch between the
variants with <A>.

4
The tangent between two circles internally.
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Drawing Tangential Construction Lines.

Command: TANPK
Code: 57 2
Parameter: Element; Angle - Inputs are made
sequentially.
Example: 57 2; Cursor to element; <CR>; 60;
<CR>.

Menu: yes
Symbol: yes

-
Abort the function with <Esc>!

Function: Draws a construction line tangential to a
circle or an arc.

1

1
Draw a tangential construction line via:

1. Menu

1. Select the function 'Draw > Tangents > Point/Circle'.
2. Move the cursor to the circle/arc and press LC
3. Use the mouse to move the tangent to the correct

position (Rotational); confirm with a click.

2. Command Line

1. Enter the command or code in the command line.
2. Move the cursor to the circle/arc and press <CR>.
3. Enter the tangent's angle and press <CR>.

The Tangent will be laid on the circle.
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2
The tangential construction line will be laid on the
circle/arc at the given angle.
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Filleting the Corner of Two Elements.

Command: VER
Code: 76
Parameter: Corner point; Radius - Inputs are made
sequentially.
Example: 76; Cursor to corner point; <CR>; 60;
<CR>.

Menu: yes
Symbol: yes

Function: Draws a fillet arc on the corner of two
elements.

A fillet can be undone via the menu .

1

1
Draw a fillet via:

1. Menu

1. Select the function 'Draw > Fillet'.
2. Move the cursor to the corner and press LC.
3. Enter the radius and confirm with a mouse click.

2. Symbol

1. Select 'fillet'.
2. Move the cursor to the corner and press LC
3. Enter the radius and confirm with a mouse click.

3. Command Line

1. Enter the command or code in the command line.
2. Move the cursor to the corner and press <CR>.
3. Enter the radius and confirm with <CR>.
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Entering Simple Text.

Command: TEXT
Code: 75
Parameter: Start point; Text - Inputs are made
sequentially.
Example: 75; Start point; Example text.

Menu: yes
Symbol: no

-
Texts are drawn based upon pre-defined
parameters. These paramters are accessible via a
Dialog , which you can reach through the menu
item 'Text > ncCAD Text > Parameter ..'.

Function: Draws simple text in a drawing.

IBECad

also offers the option to use 'True Type' texts to
create layout texts.

Note: texts should always be written with an external
contour. Internal elements should be held with
cutting bridges.

1

1
Draw a text via:

1. Menu

1. Select the function 'Text > ncCAD Text > input'.
2. Move the cursor to the start point and LC.
3. Enter the text and press <CR>.

2. Command Line

1. Enter the command or code in the command line.
2. Move the cursor to the start point and press <CR>.
3. Enter the text and press <CR>.
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2

This dialog allows the presets for entering text to be changed. Call
the dialog through the menu or the command line with the command
(TEXTP), or code (75).
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Entering True Type Texts.

Command: no
Code: 420
Parameter: Dialog; Start point - Inputs are made
sequentially.
Example: 420; Dialog; 40,40.

Menu: yes
Symbol: no

-
Texts are entered into a dialog and drawn at the
given location.

Function: Draws layout texts in your drawing using
true-type fonts.

Note: texts should always be written with an external
contour. Internal elements should be held with
cutting bridges.

1

1
Draw a text via:

1. Menu

1. Select the function 'Text > TrueType Text > Text input'.
2. Fill out the dialog and click 'apply'.
3. Move the cursor to the start point and LC.

2. Command Line

1. Enter the command or code in the command line.
2. Fill out the dialog and click 'apply'.
3. Move the cursor to the start point and <CR>.
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2

This dialog allows the presets for entering text to be changed. Call
the dialog through the menu or the command line with the command
(TEXTP), or code (75).
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Giving Dimensions in your Drawing.

When dimensioning you workpiece, you should
consider the arrangement of the dimensions
carefully and then use the relevant menu items to
locate the dimensions on your drawing in the
correct order.
When placing the first dimensioning lines, leave
yourself enough space to place any others you will
need.

Important: After aligning a dimension, you must
press <CR> or LC to place the dimensionins label!

Dimensioning with and without numbers is done in
exactly the same way, and so this procedure will
only be described once (for dimensioning with
numbers).

IBECad allows you to dimension your drawings
according to the standard rules. The programs
menus will help you dimension your drawing
correctly.

1

1
This workpiece is to be dimensioned between two
reference lines. Menu items 1. Dimensioning and 2.
Dimensioning, last Dim., Circle and Arc will be required to
align the dimensioning.
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Dimensioning a Length.

Command: BEM2T (BEM2)
Code: 54 (34)
Parameter: 1.MBP; 2.MBP; ML - Inputs are made
sequentially.
Example: 54; 1.MBP; 2.MBP; ML; <CR>; <CR>.

Menu: yes
Symbol: no

-
The codes in brackets apply for dimensioning
without measurements.

Function: Lays a dimensioning line (ML) across a
length between a first dimensioning limit point (MBP)
and a second dimensioning limit point.

1

1
Lay a dimensioning line via:

1. Menu

1. Select the function 'General > Dimensioning > XY
Dimensioning > With Measurements'.

2. Move the cursor to the first dimensioning limit point and LC.
3. Move the cursor to the second dimensioning limit point and

LC.
4. Move the cursor to the dimensioning line's position and LC.
5. LC!

2. Command Line

1. Enter the command or code in the command line.
2. Move the cursor to the first dimensioning limit point and

press <CR>.
3. Move the cursor to the second dimensioning limit point and

press <CR>.
4. Move the cursor to the dimensioning line's position and

press <CR>.
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5. Press <CR>!
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Dimensioning Using a Reference Line.

First set a first dimensioining between two limiting
points. A reference line will be laid on the second
point and (virtually to begin with) on the first limiting
point.

Command: no
Code: no
Parameter: 1.MBP; 2.MBP; ML - Inputs are made
sequentially.

Menu: yes
Symbol: no

-
Set a second dimensioning line relating to the
same first limiting point.

Command: no
Code: no
Parameter: 2.MBP

Menu: yes
Symbol: no

-
Place last dimensioning line; the reference line on
the first limiting point will finally be displayed along
with all dimensioning lines related to it.

Command: no
Code: no
Parameter: 2.MBP

Menu: yes
Symbol: no

-

Function: Lays dimensioning lines (ML) across a
length between two limiting points, whereby a
reference line is drawn from the first limiting point.
The sequence must be adhered to when adding a
dimensioning line in order to retain the relation to the
reference line.

1
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1
Laying a dimension on a reference line.
Set the first dimension via:

1. menu:

1. Select the function 'General > Dimensioning > XY Dimensioning >
First Dimensioning'.

2. Move the cursor to the first dimensioning limit point and LC.
3. Move the cursor to the second dimensioning limit point and LC.
4. Move the cursor to the dimensioning line's position and LC.
5. LC!

After the first dimensioning line, a second dimensioning line can be
related to the same reference line.

2
Setting a dimensioning line on a reference line.
Add a second dimensioning line via:

1. Menu:

1. Select the function 'General > Dimensioning > XY Dimensioning >
Second Dimensioning'.

2. Move the cursor to the second dimensioning limit point and LC.
3. LC!

After the second dimensioning line, a final dimensioning line must be
added to the reference line to close it.
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3
Laying a dimensioning line on a reference line.
Lay a final dimensioning line via:

1. Menu:

1. Select the function 'General > Dimensioning > XY Dimensioning >
Final Dimensioning'.

2. Move the cursor to the final dimensioning limit point and LC.
3. LC!
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Dimensioning Between Two Points.

Command: BEM1T (BEM1)
Code: 53 (33)
Parameter: 1.MBP; 2.MBP; ML - Inputs are made
sequentially.
Example: 53; 1.MBP; 2.MBP; ML; <CR>; <CR>.

Menu: yes
Symbol: no

-
The codes in brackets apply for dimensioning
without measurements.

Function: Lays a dimensioning line (ML) between a
first limiting point (MBP) and a second.

1

1
Lay a dimensioning line via:

1. menu

1. Select the function 'General > Dimensioning > Point
Dimensioning > With Measurements'.

2. Move the cursor to the first dimensioning limit point and LC.
3. Move the cursor to the second dimensioning limit point and

LC.
4. Move the cursor to the dimensioning line's position and LC.
5. LC!

2. Command Line

1. Enter the command or code in the command line.
2. Move the cursor to the first dimensioning limit point and

press <CR>.
3. Move the cursor to the second dimensioning limit point and

press <CR>.
4. Move the cursor to the dimensioning line's position and

press <CR>.
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5. Press <CR>!
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Dimensioning an Angle.

Command: BEMW
Code: 64
Parameter: 1.HL,1.GP; 1.HL,2.GP; 2.HL,1.GP;
2.HL,2.GP; ML - Inputs are made sequentially.
Example: 64; 1.HL,1.GP; 1.HL,2.GP; 2.HL,1.GP;
2.HL,2.GP; ML; <CR>; <CR>.

Menu: yes
Symbol: no

-

Function: Sets a dimensioning line (ML) on an angle.
The angle is limited by two reference construction
lines (HL) which are defined by a first and second
point in the drawing (GP). The ML can be located
inside or outside the arc, or be placed as an opposite
angle .

1

1
Lay a dimensioning line via:

1. menu

1. Select the function 'General > Dimensioning > 'Angle'.
2. Move the cursor to the first HL, first GP and LC.
3. Move the cursor to the first HL, second GP and LC.
4. Move the cursor to the second HL, first GP and LC.
5. Move the cursor to the second HL, second GP and LC.
6. Move the cursor to the dimensioning line's position and LC.
7. LC!

2. Command Line

1. Enter the command or code in the command line.
2. Move the cursor to the first HL, first GP and Press <CR>!.
3. Move the cursor to the first HL, second GP and Press <CR>!.
4. Move the cursor to the second HL, first GP and Press <CR>!.
5. Move the cursor to the second HL, second GP and Press

<CR>!.
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6. Move the cursor to the dimensioning line's position and Press
<CR>!.

7. Press <CR>!

The dimensioning line can also be placed internally on the angle.

2
Now for an internal dimensioning line.

An opposite angle will also be shown to give the full picture.

3
We have used the same subject here to illustrate the use of an
opposite angle, despite the fact that it is not a sensible place to use
it.
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Dimensioning an Arc.

Command: BEMB
Code: 63
Parameter: Arc; ML - Inputs are made sequentially.
Example: 63; Identify Arc; ML; <CR>; <CR>.

Menu: yes
Symbol: no

-

Function: Sets a dimensioning line (ML) on an arc.

1

1
Lay a dimensioning line via:

1. Menu

1. Select the function 'General > Dimensioning > 'Arcs'.
2. Move the cursor to the circle and LC.
3. Move the cursor to the dimensioning line's position and LC.
4. LC!

2. Command Line

1. Enter the command or code in the command line.
2. Move the cursor to the arc and press <CR>.
3. Move the cursor to the dimensioning line's position and press

<CR>.
4. Press <CR>!
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Dimensioning a Circle.

Command: BEMK
Code: 43
Parameter: Circle; ML - Inputs are made
sequentially.
Example: 43; Identify circle; ML; <CR>; <CR>.

Menu: yes
Symbol: no

-

Function: Lays a dimensioning line (ML) on a circle.

1

1
Lay a dimensioning line via:

1. Menu

1. Select the function 'General > Dimensioning > Circles'.
Move the cursor to the circle and LC.

2. Move the cursor to the dimensioning line's position and LC.
3. LC!

2. Command Line

1. Enter the command or code in the command line.
2. Move the cursor to the circle and press <CR>.
3. Move the cursor to the dimensioning line's position and press <CR>.
4. Press <CR>!
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Printing the Drawing.

There is a dialogue box with options with various
options for setting-up your printer when printing
your drawing.
There is a preview of your drawing to the left. If
there is no preview here, check the 'current' layer
checkbox.

Make all settings for your printer and print your
drawing out.

1

2

1

Use the buttons to access the printer setting for your system's
printer. The 'Preview' button re-draws the drawing. Right-click to
leave the dialogue box.
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2
As well as settings for the print
format, you can also select the
Line types and colours and
determine the Print quality .

3
Make settings about the line types
and colours here. The print quality
can be set in another frame.
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4
Make settings about the print
quality here.
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Command sequence
The sequential routine followed when drawing an element

exit 4

Command line
Line for entering drawing commands in text form.

general 4
entry format 4
show entry format 4

Edit functions
Functions with which to edit your drawing's elements.

free copy 22
copy/turn 17
scaling 28
mirror 30
move 25
clipboard 32

Dimensioning
Dimension your drawing according to the accepted norms.

general 70
reference lines 73
arcs 80
circles 81
menu 12
points 76
lengths 71
angles 78

Arcs
An arc as a segment of a circle.

menu 9
mid-point 47
points (through 3) 48
tangential 50
tangential (2 elements) 52

Cursor
The Cursor is the basic tool for drawing and identifying.
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general 3
triangular calculation 5
info 4
polar coordinates 5
position 5
X/Y coordinates 5

Printer
Printing dialog for the system printer.

preview 82
set-up 83
quality 85

DXF
DXF is a standardised file format for CAD drawings.

import 6

Entry format
Format for entering drawing commands in text fields.

general 5

Corners
The corner of two elements.

geometric element
fillet 65
create 10

Element
Describes a geometric element.

geometric element
symbol 14

Ellipses
Ellipses as closed elements.

from arcs 57
from lines 55
function 54
menu 9

format
Set rules for colours, lines and pens.

set 7
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grid 11
text 68
true type text 70

Format line
The format line shows the current drawing settings.

general 4

Geometric elements
Geometric elements make up your workpiece.

fit 15
identify 7
info 4
symbol 13

Geometric points
Geometric points are single points on geometric elements.

info 4
values 14
tip 4

Construction lines
Construction lines as the basis of a construction.

symbol 14
tip 14

Identifying
Identifying geometric elements.

elements (multiple) 13
function 13
groups of contours 13
menu 7
symbol 13

Coordinates
Position input for the cursor and elements.

polar 5
x/y 5

Circles
Circles as closed elements.

fit 10
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separate 10
elements (against three) 44
elements (against two) 42
through a point 45
menu 9
radius 41
symbol 14
split 10
trim 10
join 10

Lines
Lines are the foremost type of element.

current 4
printer 84
colours 8
function 38
menu 8
pen type 8
symbol 14
types 8

Menu panel
The menu panel aids navigation and set-up of the program.

general 5

Zero-point
A zero-point is the reference point for a drawing operation.

current 5
set 37
function 36
zero-point 0 4
menu 7
zero-point 1 3
select 37

Grid
Markings on the drawing field to help you draw.

dialog 11
show/hide 4
tip 4

Rectangles
Rectangles as groups of lines.
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function 40
menu 8
symbol 14

Start-point
The start-point gives the location to start a drawing operation.

function 37
set 38

Status panel
The status panel gives important information about your drawing.

current zero-point 5
general 5
layer number 5

Symbol panel
Drawing commands swapped for one-click icons.

general 12

Tangents
Tangents on arcs and circles.

elements (against two) 61
function 59
construction lines 63
menu 10
symbol 14

Text
Text as ncCAD-text or true type text.

dialog 70
simple 66
menu 10
true type 68

Fillet
Filleting the corner of two elements.

undo 10
function 65
menu 8
symbol 14

Drawing field
The drawing field is the work area for drawing your component - your virtual drawing board.
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general 3
right-click 3

Drawing
'Drawing' describes a workpiece saved as an individual file.

general 1
region-scale 10
display 4
print 83
import 6
function 34
create new 6
symbol 15
zoom 3
zoom window 7
drawing field 3
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A angles (Dimensioning) 78
arcs (Dimensioning) 80

C circles (Dimensioning) 81
clipboard (Edit functions) 32
colours (Lines) 8
construction lines (Tangents) 63
copy/turn (Edit functions) 17
create (Corners) 10
create new (Drawing) 6
current (Lines) 4
current (Zero-point) 5
current zero-point (Status panel) 5

D dialog (Text) 70
dialog (Grid) 11
display (Drawing) 4
drawing field (Drawing) 3

E elements (against three) (Circles) 44
elements (against two) (Tangents) 61
elements (against two)  (Circles) 42
elements (multiple) (Identifying) 13
entry format (Command line) 4
exit (Command sequence) 4

F fillet (Corners) 65
fit (Geometric elements) 15
fit (Circles) 10
free copy (Edit functions) 22
from arcs (Ellipses) 57
from lines (Ellipses) 55
function (Ellipses) 54
function (Rectangles) 40
function (Fillet) 65
function (Start-point) 37
function (Lines) 38
function (Identifying) 13
function (Drawing) 34
function (Tangents) 59
function (Zero-point) 36

G general (Entry format) 5
general (Menu panel) 5
general (Status panel) 5
general (Drawing field) 3
general (Symbol panel) 12
general (Drawing) 1
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general (Cursor) 3
general (Dimensioning) 70
general (Format line) 4
general (Command line) 4
grid (format) 11
groups of contours (Identifying) 13

I identify (Geometric elements) 7
import (Drawing) 6
import (DXF) 6
info (Geometric points) 4
info (Geometric elements) 4
info (Cursor) 4

J join (Circles) 10

L layer number (Status panel) 5
lengths (Dimensioning) 71

M menu (Identifying) 7
menu (Fillet) 8
menu (Zero-point) 7
menu (Arcs) 9
menu (Circles) 9
menu (Lines) 8
menu (Rectangles) 8
menu (Tangents) 10
menu (Dimensioning) 12
menu (Text) 10
menu (Ellipses) 9
mid-point (Arcs) 47
mirror (Edit functions) 30
move (Edit functions) 25

P pen type (Lines) 8
points (Dimensioning) 76
points (through 3) (Arcs) 48
polar (Coordinates) 5
polar coordinates (Cursor) 5
position (Cursor) 5
preview (Printer) 82
print (Drawing) 83
printer (Lines) 84

Q quality (Printer) 85

R radius (Circles) 41
reference lines (Dimensioning) 73
region-scale (Drawing) 10
right-click (Drawing field) 3

S scaling (Edit functions) 28
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select (Zero-point) 37
separate (Circles) 10
set (format) 7
set (Start-point) 38
set (Zero-point) 37
set-up (Printer) 83
show entry format (Command line) 4
show/hide (Grid) 4
simple (Text) 66
split (Circles) 10
symbol (Rectangles) 14
symbol (Geometric elements) 13
symbol (Element) 14
symbol (Identifying) 13
symbol (Construction lines) 14
symbol (Fillet) 14
symbol (Lines) 14
symbol (Tangents) 14
symbol (Drawing) 15
symbol (Circles) 14

T tangential (Arcs) 50
tangential (2 elements) (Arcs) 52
text (format) 68
through a point (Circles) 45
tip (Geometric points) 4
tip (Grid) 4
tip (Construction lines) 14
triangular calculation (Cursor) 5
trim (Circles) 10
true type (Text) 68
true type text (format) 70
types (Lines) 8

U undo (Fillet) 10

V values (Geometric points) 14

X x/y (Coordinates) 5
X/Y coordinates (Cursor) 5

Z zero-point 0 (Zero-point) 4
zero-point 1 (Zero-point) 3
zoom (Drawing) 3
zoom window (Drawing) 7
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